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Chapter 1 Introduction 

This Wireless LAN Access Point provides a flexible way for users to configure their 
network by eliminating LAN wiring. With the slick Windows-based configuration 
tools, users can easily deploy and control this access point. Advanced user 
authentication ensures a high level of security for wireless networking. In additional 
to corporate use, this Access Point can also be implemented in the public arena such 
as airports, hotels, etc.. 
 

1.1 Package Contents 

The Wireless Access Point includes the following items: 
y One Wireless LAN Access Point 
y One Power Adapter 
y One USB Cable  
y One Driver/Utilities/Manual CD 
y One User’s Manual 
 

1.2 Features 

y Compiles with the IEEE 802.11b (DSSS) 2.4GHz specification. 
y High data rate 11, 5.5, 2 and 1Mbps network speed. 
y Seamlessly integrate the Wireless and Ethernet LAN networks. 
y Interoperable with IEEE 802.11b compliant wireless equipments. 
y Support 64(40)/128-bit Wired Equivalent Privacy encryption protocol 
y Support Wireless Access Point Roaming and Bridging. 
y Supports building-to-building wireless bridging. 
y Auto switch to external Antenna in bridge application. 
y Supports RTS and CTS threshold control for better throughput. 
y Auto rate fallback in case of obstacles or interference. 
y Configuration control via USB port or Ethernet port. 
y Supports SNMP Utility Management. 
y Easy traffic monitoring (SNMP program). 
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y Plug-and-play installation. 
y Desktop and wall mountable design. 
 

1.3 Specifications 

y Standards: IEEE 802.3 and IEEE 802.3u (Wired), IEEE 802.11b (Wireless) 
y Data Rate: 11, 5.5, 2, and 1Mbps 
y Security: 64(40)/128-bit WEP data encryption 
y Frequency Band: 2.400~2.4835GHz (Industrial Scientific Medical Band) 
y Operating Channels:  

Channels 1-11 (US, Canada) 
Channels 1-13 (Europe ETSI) 
Channels 1-14 (Japan) 
Channels 10-11 (Spain) 
Channels 10-13 (France) 

y Connectors:  
One USB port 
One 10/100Mbps RJ-45 
One SMB connector for external antenna or booster 

y Antenna: Diversity Antenna inside. 
y Modulation: CCK@11/5.5Mbps, DQPSK@2Mbps and DBPSK@1Mbps 
y Radio Technology: Direct Sequence Spread Spectrum (DSSS) 
y Operating Range:  

Indoor:     35-100m 
Outdoor: 100-300m 

y Configuration Utility:  
Windows Configuration Utility supports USB interface configuration 
SNMP Utility: Available for wired stations with Windows 98/98SE/Me/ 

2000/XP 
y LEDs: Power, LAN Link/Activity, Wireless TX/RX 
y Power: 5VDC, 1.4A 
y Power Consumption 

Transmit: Less than 800 mA 
Receive: Less than 700 mA 

y Transmission Power: 14 dBm (Normal)@ -30 dB Side lobe 
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y Receive Sensitivity: 

-80 dBm @FER=8% , 11 Mbps. 
-83 dBm @FER=8% , 5.5 Mbps 
-86 dBm @FER=8%, 1 Mbps 

y Dimension: 190(H) x 65(W) x 130(D) mm 
y Temperature:  

Operating: 32~122°F (  0 ~50°C) 
Storage   :-13~149°F (-25~65°C) 

y Humidity: 10-95% (Noncondensing) 
y Certifications:  

Canada/U.S.A FCC Part 15C, sections 15.247, 15.205, 15.209, RSS-210 
Europe: ETS 300.328, ETS 300.826 
CE Mark 

 

1.4 System Requirement 

y Computer with USB or Ethernet connection 
y Windows 98, 98SE, Millennium, 2000 Professional or XP. 
 

1.5 Physical Description 

Front Panel 
On the Access Point’s front panel there are LED lights that inform you of the Access 
Point’s current status. Below is an explanation of each LED. 
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LED Color Status Description 

Lit Power is supplied. 
Power Green 

Off No Power. 
    

Lit A valid link is established. 
Flash Data packets are received. 

LAN 
Link/Activity 

Green 
Off No link is established. 

    
Amber Flash Antenna is transmitting data. 
Green Flash Antenna is receiving data. 

Wireless 
TX/RX 

 Off Antenna is not transmitting or receiving data.
 
Back Panel 
Access Point’s connection ports are located on the back panel. Below is the 
description of each connection port. 
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y USB Port 

The USB port which connects to an USB-ready PC is used to configure the 
Access Point. To work with USB port, the PC must be running Windows 98, Me, 
2000 or XP. 
 

y DC Adapter Port 
Insert the power jack of the power adapter into this port. 

 
y 10/100Mbps 

This port connects to Ethernet network devices, such as a hub, switch, or router. 
 
y Reset 

If problems occur with the Access Point, press the Access Point’s reset button 
with a pencil tip and the Access Point will re-boot itself immediately. 

 
y SMB Antenna Connector 

The SMB Antenna Connector is where external antenna is connected to the 
Access Point. While external antenna is connected, the internal antenna will be 
disabled automatically. 
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Chapter 2 Wireless LAN Access Point 
Connection 

1. Locate an optimum location for the Wireless LAN Access Point.  
The best location for your Wireless LAN Access Point is usually at the center of 
your wireless network, with line of sight to all of your mobile stations. 
 

2. Connect the Wireless LAN Access Point to your 10/100Mbps network. 
Connect one end of standard UTP cable to the Wireless LAN Access Point’s 
10/100Mbps RJ-45 connector and connect the other end of the cable to a switch or 
a hub. The Wireless LAN Access Point will then be connected to your 
10/100Mbps Network. 
 

3. For configuration purposes, connect the Wireless LAN Access Point to your 
PC through the USB port. 
If the USB port of your PC is working properly, your system should immediately 
recognize the Access Point and attempt to install a driver for it. Make sure that the 
Setup CD is inserted into your CD-ROM drive and then follow the instructions of 
the setup program. Select Specify a location and type in the blank field D:\ 
Driver\Winxxx (where “D” specifies your CD-ROM) to install the driver 
automatically. The driver supports Windows 98/98SE/Me/2000/XP operating 
systems. 
Note:  Windows 2000 driver can also be used as Windows XP driver. 
 

4. Connect the AC Power Adapter to the Wireless LAN Access Point’s Power 
Socket.  
Only use the power adapter supplied with the Wireless LAN Access Point. Using 
a different adapter may damage the product. 

 
The Hardware Installation is complete.
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Chapter 3 Wireless LAN Access Point 
Configuration 

Two software tools are provided to configure the Access Point. 

� AP Utility 
The AP Utility can be used when configuring the Wireless LAN Access Point 
through a USB connection and is compatible with Windows 98, Millennium, 
2000 and XP. 

 

� Access Point SNMP Manager 
The Access Point SNMP Manager can be used when configuring the Wireless 
LAN Access Point through an Ethernet connection and is compatible with all 
Windows Operating Systems. You may also use the SNMP Manager configure 
the Access Point wirelessly. 
 

3.1 AP Utility 

3.1.1 How to Install the AP Utility 

Please run the program “setup.exe” which you will find in the “DFU” subfolder of 
the “Utilities” folder in your CD. Follow the instructions of the setup program and 
select the directory where the application is installed. 
 

3.1.2 Using the AP Utility 

Before using the AP Utility Application, please make sure you have plugged the USB 
cable to the Access Point USB port and installed the driver of the Access Point (see 
Chapter 2 for the installation) and the AP Utility Application. 
 
On the Start Menu, choose Start->Programs->Atmel Utilities->DFU->DFU to run the 
AP Utility Application. Then, select the Configuration button to start configuring. 
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You can use the Get, Modify and Set buttons to configure the parameters for the 
Wireless LAN Access Point. 
“Get”         View the current parameters of the Access Point. 
“Modify”   Set new values to the pre-selected parameters. 
“Set”          Download any changes to the Access Point. 
 
For Example: 
1. Press the Get button to view all the current parameters of the Access Point. 
2. Click one of the parameters you would like to configure. 
3. Press the Modify button and a sub-window for the parameter setting will be 

displayed. 
4. After changing the values, press the Set button to confirm the setting is completed. 
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The parameters for the Wireless LAN Access Point are described below: 
 
Parameters Description 
MAC Address The MAC Address of the Access Point. 
  
Regulatory Domain This parameter is used to designate the Access Point’s 

regulatory domain. There are seven domains you can set 
including FCC, DOC, ETSI, SPAIN, FRANCE, MKK 
and MKK1. Note that the Regulatory Domain and the 
Wireless Channel parameter have the specific 
corresponding relation listed as below. 
FCC (USA):  1-11        DOC (Canada): 1-11 
ETSI (Europe): 1-13    SPAIN:  10-11 
FRANCE: 10-13          MKK: 14 
MKK1: 1-14 

  
Ethernet IP Address The IP address of the Access Point. This IP Address must 

be unique to your network. The default IP Address of 
Access Point is 10.170.254.32. 

  
Ethernet Subnet Mask The Ethernet station and the Access Point must be on the 

same subnet. The IP address for the Access Point must 
correspond to the Subnet Mask. The default Subnet Mask 
of Access Point is 255.255.254.0. 

  
Wireless MAC Address Specifies the BSSID. It must be the same as the Ethernet 

MAC Address. 
  
ESSID The ESSID (up to 32 printable ASCII characters) is the 

unique name identified in a WLAN. The ID prevents the 
unintentional merging of two co-located WLANs. Please 
make sure that the ESSID of all points in the network are 
the same. 

  
ESSID Length The length of the ESSID (number of characters). 
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Parameters Description 

Auto Rate Fall Back Select Enable or Disable. When this is enabled, the 
wireless network provides more flexibility when wireless 
devices roam. As wireless devices move away from the 
Access Point, the transfer rate will automatically fall 
back to the most optimum rate allowed. 

  
Wireless Channel Select the channel to be used. Channels differ from 

country to country. There are 14 channels available. 
  
WEP type Select the 64(40) or 128 bits Wired Equivalent Privacy 

Algorithm. 
  
WEP key Select one of the keys (1~4) as the WEP encryption key 

for transmissions between stations and the Access Point. 
  
Wireless Fragmentation 
Threshold 

The size of the packets to be fragmented. Enter a value 
within a range of 256 to 2346 bytes. 

  
Wireless RTS Threshold Minimum packet size required for an RTS (Request To 

Send) transmission. For packets smaller than this 
threshold, an RTS is not sent and the packet is 
transmitted directly to the WLAN. The value is in a range 
of 256 to 2346 bytes. 

  
WEP Keys #1 - #4 The default key that will be used. May be edited when 

WEP type is 64(40) bits. Enter 10 digit Hex values (in the 
range of “A-F”, “a-f” and “0-9”) as the encryption keys. 

  
Preamble Type The preamble defines the length of the CRC block for 

communication between the Wireless LAN Access Point 
and the roaming Wireless Stations. The Short Preamble 
option improves throughput performance. 
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Parameters/Buttons Description 

Authentication Type Defines the Access Point’s authentication type. Only the 
Wireless Stations that pass the authentication test can 
connect to the Access Point. 
y Open System: any stations can associate with the 

Access Point without authentication. 
y Shared Key: stations using a shared key (the WEP Key 

identified by the Access Point) can associate with the 
Access Point. 
y Both: any stations can associate with the Access Point 

with or without authentication. 
  
Access Point Name Enter the Access Point’s name. 
  
Operational Rate Set By default the Access Point adaptively selects the highest 

possible rate for transmission. In case of obstacles or 
interference, the system will adjust the speed 
automatically. Select the basic rates to be used: 82 84 8B 
96 (1-2-5.5-11 Mbps) or 82 84 0B 16 (1-2 Mbps). 

  
Beacon Period Set the Beacon Period parameter, which specifies the 

duration between beacon packets (milliseconds). The 
range for the beacon period is between 20-1000 with a 
typical value of 100. 

  
DTIM Determines the interval the Access Point will send its 

broadcast traffic. Default value is 4 beacons. 
  
Receive Antenna Sets which antenna is used for reception. Select Diversity 

Antenna for the Access Point. 
  
Transmit Antenna Sets which antenna is used for transmission. Select 

Diversity Antenna for the Access Point. 
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Parameters/Buttons Description 

Operational Mode Sets this Access Point to following operational mode. 
• Access Point 
• Access Point Client 
• Wireless Bridge 

  
User Community Indicates the user’s password. The default password is 

“public”. 
  
User Access Indicates the user’s access rights. You can restrict the 

user to read only. 
  
Administrator 
Community 

Indicates the administrator’s password. The default 
password is “public”. 

  
Administrator Access Indicates the Administrator’s access rights. 
  
Manufacturer 
Community 

Indicates the manufacturer’s password. 

  
Manufacturer Access Indicates the manufacturer’s access rights. 
  
Gateway IP Address Network Gateway. 
  
IP Filtering When this is enabled, only IP protocol packets can pass 

through the Access Point. 
  
DHCP Client When this is enabled, the IP Address of the Access Point 

will be assigned by a DHCP Server automatically. 
  
Primary Port The interface connected to the DHCP Server. 
  
Authorization Algorithm Enable/Disable the authorized MAC Address stations to 

connect to the Access Point. 
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Parameters/Buttons Description 

SNMP Traps Enabled/Disabled SNMP traps which are messages 
indicating that an action related to the Access Point took 
place. These messages will be displayed in the main 
window of the SNMP Manager tool. 

  
WEP 128 keys #1-#4 The default key that will be used while WEP type is 128 

bits. Enter 26 digit Hex values in the range of “A-F”, “a-
f” and “0-9” for encryption keys. 
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3.2 Access Point SNMP Manager 

3.2.1 How to Install the SNMP Manager 

Step 1: Insert the Setup CD and run the program “setup.exe” which you will find 
under the Utilities\SNMP folder in your CD. You will see the welcome page 
of the installation program. Click Next to continue. 

 

 
 
Step 2: Read the terms of the License Agreement, and if you agree, click Yes; 

otherwise, click No to cancel installation. 
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Step 3: The Choose Destination Location screen will show you the default 
destination chosen by the program. If you want to install this in another 
location, click the Browser button and select an alternate destination. When 
you are ready to continue, click the Next button. 
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Step 4: In this frame you will find where the program will be installed. If you want to 
change the program folder, please type the name in the Program Folders field. 
Click Next to continue. 
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Step 5: All the settings of this installation will be shown in the following screen. 

Click Back to change the settings; otherwise, click Next to continue. 
 

 
 

Step 6: The SNMP Manager has now been installed. Select Yes to restart your PC. 
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3.2.2 Using the SNMP Manager 

Before using the SNMP Manager to configure the Access Point, verify the Ethernet 
station and the Access Point are on the same subnet. The following is the default IP 
address and Sub Mask of the Access Point: 
Default IP Address: 10.170.254.32 
Default Sub Mask:  255.255.254.0 
 
In order to change the IP address and Sub Mask of the Access Point, you must use the 
AP Utility Application (only through the USB port). Please refer to Section 3.1.2 for 
the IP Address and Sub Mask configuration. 
 
On the Start Menu, choose Start->Programs->Atmel Utilities->AP Configuration-
>AP Configuration to start using the configuration tool. 
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3.2.2.1 Connecting to the Access Point 

� Connect to the Access Point 
Pull down the File menu and select the Connect to Access Point submenu. You 
can directly connect with the Access Point by typing its IP Address and 
appropriate password (The default password is "public"). Additionally you have 
to select the User or Administrator Authority in the Authority combo-box. User 
Authority allows you to view the Access Point Configuration, while 
Administrator Authority allows you to view and change the Access Point 
Configuration. 
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� Find Access Point 

Pull down the File menu and select the Connect to Access Point submenu. This 
submenu allows you to find and connect with an Access Point without knowing 
its IP Address. Select the available Access Points and press the Connect button 
to connect with it. 
 

 
 

3.2.2.2 Configuring the Access Point 

� Download Changes 
When all the desired values of the parameters have been set, pull down the File 
menu and select the Download Changes submenu to save all the changes. 
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� Refresh 

If you want to get the original setting on the Access Point, pull down the File 
menu and select the Refresh submenu. 
 

� IP Configuration 
Pull down the Setup menu and select the IP Configuration from the Bridge 
submenu. You can modify the IP Address and IP Mask through this window 
directly. If DHCP is enabled, select the primary port where the DHCP server is 
connected. 
 

 
 
� Filtering Configuration 

Pull down the Setup menu and select the Filtering from the Bridge submenu. If 
IP Routing is enabled, only the IP protocol packets will pass through the WLAN 
and any other protocols will be filtered out. 
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� Privacy Options 

Pull down the Setup menu and select the Privacy Options from the Wireless 
LAN submenu. 
y Key 1~Key 4 

64(40)-bit WEP: input 10 digit Hex values (in the “A-F”, “a-f” and “0-9” 
range) as the encryption keys. 
128-bit WEP: input 26 digit Hex values (in the “A-F”, “a-f” and “0-9” range) 
as the encryption keys. 

y Default Key 
Only the key you select it in the “Default key” will take effect. 

y WEP 
Enable 64(40)-bit or 128-bit WEP (Wired Equivalent Privacy) to activate the 
WEP encryption for transmissions between stations and the Access Point.  

 
Note: WEP is an authentication algorithm which protects authorized Wireless 
LAN users against eavesdropping. The Authentication type and WEP key 
must be the same on the wireless station and on the access point. 

 

 
 

� Operational Settings 
Pull down the Setup menu and select the Operational Settings from the 
Wireless LAN submenu. Using this option you can either view or modify the 
parameters of the Access Point. 
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y Access Point Name 

Fill in a user-friendly name for the Access Point. 
y ESSID 

This is an up to 32 characters ASCII string used to identify a WLAN that 
prevents the unintentional merging of two co-located WLANs. The ESSID 
value must be the same in all stations and Access points in the extended 
WLAN. 

y Channel 
There are 14 channels available. The channels differ from country to country. 

y Regulatory Domain 
This parameter is used to designate the Access Point’s regulatory domain. 
There are seven domains you can set including FCC, DOC, ETSI, SPAIN, 
FRANCE, MKK and MKK1. Note that the Regulatory Domain and the 
Wireless Channel parameter have the specific corresponding relation listed as 
below. 
FCC (USA):  1-11 
DOC (Canada): 1-11 
ETSI (Europe): 1-13 
SPAIN:  10-11 
FRANCE: 10-13 
MKK: 14 
MKK1: 1-14 

y Fragmentation Threshold 
The size of the packets will be fragmented. Select a setting within a range of 
256 to 2346 bytes. 

y RTS Threshold 
Minimum packet size required for an RTS (Request To Send). For packets 
smaller than this threshold, an RTS is not sent and the packet is transmitted 
directly to the WLAN. 

y Rate 
The basic transfer rates should be set depending on the speed of your wireless 
networks. Select the basic rates to be used among the following options 1-
2Mbps, 1-2-5.5-11Mbps. 
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y Auto Rate Fall Back 

When this is enabled the transmission rate is the optimum rate. In case of 
obstacles or interference, the system will automatically fall back. 

y Authentication Type 
Open System:  

Any station in the WLAN can associate with an Access Point and 
receive and transmitted data without authentication. 

Shared Key:  
Only stations using a shared key (WEP Key identified by the Access 
Point) are allowed to associate with the Access Point. 

Both:  
Stations can communicate with the Access Point either with or without 
data encryption. 

y Preamble Type 
The preamble defines the length of the CRC block for communication 
between the Wireless Access Point and the roaming Wireless Stations. The 
Short Preamble option improves throughput performance. 

y Rx Antenna  
Sets which antenna is used for reception. Select Diversity Antenna for the 
Access Point. 

y Tx Antenna 
Set which antenna is used for transmission. Select Diversity Antenna for the 
Access Point. 
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� Modify Authorized MAC Address 
Pull down the Setup menu and select the Authorized Mac Address from the 
Wireless LAN submenu. For security reasons the Access Point is able to 
associate with authorized MAC Address stations. 
y Load File 

You can build a text file that consists a list of MAC Address,  
Ex. 001122334125 
      221032554111 
and press Load File button to load these MAC Addresses to the table. 

y Download 
Download the Access Point’s Authorized MAC Addresses. 

y Get 
Get the Access Point’s Authorized MAC Addresses. 
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y Authorization Table Enable 

If checked, only devices with MAC Addresses in the Authorization Table can 
connect to the Access Point. 

 

 
 

� Enable SNMP Traps 
Pull down the Setup menu and select the Enable SNMP Traps submenu to 
enable or disable SNMP traps. SNMP Traps are messages indicating the action of 
the Access Point displayed in the right bottom corner of the main window. 
y Trap Reassociation 

This trap message is sent when a station’s reassociation request is received 
from the Access Point-Bridge. 

y Trap Association 
Indicates the reception of an association request packet and the sender 
station's successful association with the Wireless Bridge. 

y Trap Disassociation 
This trap message is sent when a disassociation notification packet is received 
from a station. 

y Trap Reset 
This trap message is sent when the Access Point-Bridge resets. 
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If you want to view additional information for every Trap Message, you could 
pull down the Traps menu and select the View Record submenu. 
 

 
 

� Authorization (Password Setting) 
Pull down the Setup menu and select the Authorization submenu to setup the 
Administrator and User’s password. 
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� Reset Device 

You can reset the Access Point. This action takes place after a user makes 
configuration changes in order to initiate the changes. 

 
� Restore Default 

You can restore the factory default values of the Access Point. 
 
� Associated Station 

Pull down the Network menu and select the Associated Station. This screen 
shows the MAC Address of the associated stations with the Access Point. 

 
� Window 

Under Window menu, there are two submenus: 
y Cascade 

All opened windows are arranged on the desktop in a cascaded fashion. 
y Tile 

All open windows are visible on the desktop. 
 
� Help 

Provides on-line help for the application. 
 

3.2.2.3 Viewing the Wireless Statistics 

� Polling Interval 
Pull down the File menu and select the Options submenu to define the polling 
interval the SNMP Manager polls the Access point in order to update the 
statistics and the Associated Stations List. 
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� Wireless Statistics 

Pull down the Info menu and select the Wireless Statistics submenu to view the 
report about the Access Point’s activity. 
 

 
 
� Ethernet Statistics 

Pull down the Info menu and select the Ethernet Statistics submenu to view the 
report about the Access Point’s Ethernet Port activity. 
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Chapter 4 Wireless LAN Access Point 
Firmware Upgrade 

Two software tools are provided to upgrade Access Point’s firmware. 

� AP Utility 
The AP Utility can be used to upgrade Access Point’s firmware through a USB 
connection and is compatible with Windows 98, Millennium, 2000 and XP. 

 

� TFTP Client 
The TFTP Client can be used to upgrade Access Point’s firmware through an 
Ethernet connection or its wireless connections. 
 

4.1 AP Utility 

Before using the AP Utility Application, please make sure you have plugged the USB 
cable to the Access Point USB port and have installed the driver of the Access Point 
and the AP Utility Application. 
 
Run the AP Utility Application and select the  button. Select the file path of the 
new firmware and then press the Download button to upgrade the firmware. 
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4.2 TFTP Client 

4.2.1 How to Install the TFTP Client 

Please run the program setup.exe which you will find under DFU\FirmwareUP 
folder in your CD. Follow the instructions of the setup program and select the 
directory where the application is installed. 
 

4.2.2 Using the TFTP Client 

On the Start menu, choose Start->Program->Atmel Utilities->FW Upgrade->FW 
Upgrade to start the program. The following screen appears. Type the IP address of 
the Access Point in the first edit box of the panel. Then, press the  button to 
select the file path of the new firmware and then press the Download Image button 
to upgrade the firmware. 
 
 
 

Download from Www.Somanuals.com. All Manuals Search And Download.



Wireless LAN Access Point Firmware Upgrade 

 32
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Chapter 5 Troubleshooting 

This chapter provides solutions to problems usually encountered during the 
installation and operation of the Wireless LAN Access Point.  
 
1. Can the Wireless Access Point act as my DHCP Server? 

No. The Access Point is nothing more than a wireless hub, and, cannot be 
configured to handle any DHCP server capabilities. 

 
2. Can the Wireless Access Point connect to PC directly? 

Yes. The Wireless Access Point can be connected to a PC through the use of a 
crossover UTP cable. Connect one end of the cable to the Ethernet Port of the 
Wireless Access Point and the other end to the PC’s NIC card. Make sure the 
Access Point and your PC are in the same subnet. You can use the SNMP 
Manager to configure the Wireless Access Point directly without building a real 
WLAN network. 
 

3. What is Ad-hoc? 
An Ad-hoc wireless LAN is a group of computers, each with a WLAN adapter, 
connected as an independent wireless LAN. 
 

4. What is Infrastructure? 
An integrated wireless and wired LAN is called an Infrastructure configuration.  
 

5. What is BSS ID? 
A group of wireless stations and an Access Point compose a Basic Service Set 
(BSS). Computers in a BSS must be configured with the same BSSID. 
 

6. What is ESSID? 
An Infrastructure configuration could also support roaming capability for mobile 
workers. More than one BSS can be configured as an Extended Service Set (ESS). 
Users within an ESS could roam freely between BSSs while maintaining a 
continuous connection to the wireless network stations and the Wireless LAN 
Access Points. 
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7. Can data be intercepted while transmitting through the air? 

WLAN features two-fold protection in security. On the hardware side, as with 
Direct Sequence Spread Spectrum technology, it has the inherent scrambling 
security feature. On the software side, the WLAN series offers the encryption 
function (WEP) to enhance security and access control. 
 

8. What is WEP? 
WEP stands for Wired Equivalent Privacy, a data privacy mechanism based on a 
64(40)-bit shared key algorithm. 

 
9. What is a MAC Address? 

The Media Access Control (MAC) address is a unique number assigned by the 
manufacturer to any Ethernet networking device, such as a network adapter, that 
allows the network to identify it at the hardware level. For all practical purposes, 
this number is usually permanent. Unlike IP addresses, which can change every 
time a computer logs on to the network, the MAC address of a device stays the 
same, making it a valuable identifier for the network. 
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